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 Evolution of Computers

OneOne LearnTouch

A.	 1. a.	 2. c.	 3. c.	 4. a.	 5. b.

B.	 1. Charles Babbage	 2. Lady Ada Lovelace	 3. John Mauchly      4. IBM      5. ENIAC

C.	 1. F	 2. F	 3. F	 4. T

ItLet's Do

A.	 1.	� The people used to calculate or count with the help of fingers, toes, pebbles, stones, sticks 
and bones in earlier times. 

	 2.	 Fourth generation of computers used microprocessors. 
	 3.	 Charles Babbage invented Analytical Engine.
	 4.	 Computers have zero IQ and hence lack the decision making power.
B.	 1.	� First generation computers were made up of vacuum tube. Whereas, second generation 

computers were made up of transistors.
	 2.	 a. �ENIAC was the first electronic general purpose digital computer built in 1946 by John 

Mauchly and Presper Eckert. It contained over 18,000 vacuum tubes and was 1000 times 
faster than Mark-I.

		  b. �Abacus is wooden frame with beads on parallel wires which can do simple calculations like 
addition and subtraction.

	 3.	 Two features of fifth-generation computers are:
		  a. They use artificial intelligence.
		  b. They improved size, cost, speed and performance.
	 4.	� Two characteristics of a computer are:
		  a. �Accuracy: A computer provides a high degree of accuracy. Every calculation is performed 

with the same accuracy. 
		  b. �Diligence: A computer can work for hours without any breaks or boredom. It does not 

get tired. 
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		  Two limitations of a computer are:
		  a. �Lack of decision-making ability: A computer does not have a brain like human beings. 

It cannot take a decision on its own. It can only perform the tasks that are instructed by 
human being. 

		  b. �Lack of intelligence: A computer is not gifted with intelligence as human beings are.  
It can only work as per the instructions given by human beings. 

Crack CodeThe

A.	 1. Charles Babbage- Difference Engine and Analytical Engine 
	 2. John Mauchly- ENIAC and UNIVAC 
	 3. Blaise Pascal- Pascaline 
	 4. Herman Hollerith- Tabulating machine
	 5. Gottfried Wilhelm Leibniz- Step Reckoner 

B.	 1. First mechanical Calculator- 1642 
	 2. First Electronic Computer- 1946 
	 3. First mechanical computer- 1833
	 4. First version of Microsoft Windows released- 1985

Do yourself.

 Computer Software

OneOne LearnTouch

A.	 1. b.	 2. c.	 3. b.	 4. c.	 5. c.
B.	 1. T	 2. F	 3. F	 4. F
C.	 1. d	 2. c	 3. a	 4. b	 5. e

ItLet's Do

A.	 1.	 Operating system serves as an interface between the user and the hardware.

	 2.	 MS word, MS PowerPoint & Coral draw are the three general purpose softwares.

	 3.	� An Operational Support System (OSS) is a group of computer programs. It is used by 
Telecommunication Service Providers (TSP) for monitoring, controlling, analyzing and managing 
a computer or telephone network system. It is also called Operation Support System.
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B.	 1.	� System software is the most important software to operate a computer. System software 
can be classified into three categories: Operating System, Programming Software and Utility 
Software.

	 2.	� Programming software is the software used by the computer to understand and convert 
the instructions by programming language into machine language. Compilers, assemblers, 
debuggers, interpreters, etc. are examples of programming software.

	 	� An assembler is a program used to translate assembly language into machine language so 
that the computer can understand it. Whereas An interpreter is also a separate program that 
converts the entire source program into machine language before executing it. An interpreter 
translates and executes one statement at a time.

	 3.	� Application software is a program designed to help users perform specific tasks. It is designed 
to be used by end-users. Backup Utility is used for keeping the backup files for emergency.

Crack CodeThe

A.	 1. Word processor	 2. Anti-virus software	 3. Data compression program

Do yourself.

 Advanced Features of Word 2019

OneOne LearnTouch

A.	 1. (This question was printed incorrectly in the book, please correct it in your textbook)

	 Q. Where is the header printed on a page in the document?

	 Ans. a.	

	 2. c.	 3. b.	 4. c.	 5. c.

B.	 1. F	 2. F	 3. T	 4. F	 5. T

C.	 1. portrait      2. layout	 3. subscript      4. footer

ItLet's Do

A.	 1.	 Footer is the text like page number that appears at the bottom of each page of the document.

	 2.	 Page margin is the white space all around the printed area of the paper.

	 3.	 Portrait & Landscape are the two page orientations in Word.

3.
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B.	 1.	� Find and Replace feature of Word is used to substitute a word with another word. To substitute 
a word or phrase with another word or phrase, follow these steps:

		  Step 1	 Click on Home tab.

		  Step 2	� Click on Replace tool.

		  Step 3	 Type the word/words to be searched and replaced in the Find what box.

		  Step 4	 Type the word/words to replace with in the Replace with box.

		  Step 5	� Click on Find Next button.

		  Step 6 	Click on Replace button to replace the searched text.

	 2.	� Column is used to break the text into two columns. Whereas, Column break is used to shift 
text from one column to another.

	 3.	� Tabs move the cursor one-half inch by default. They work when we press the Tab key on the 
keyboard. The position where the cursor moves on pressing the Tab key is called Tab stop. 
If we place the cursor at the beginning of a paragraph and press Tab key, the first line of the 
paragraph gets indented by ½ inch.

Crack CodeThe
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Do yourself.

 Graphics in Word 2019

OneOne LearnTouch

A.	 1. b.	 2. a.	 3. c.	 4. c.	 5. a.

4.
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B.	 1. shapes    2. Insert	    3. WordArt      4. 3D

C.	 1. Shapes    2. WordArt    3. Picture    4. Symbol

ItLet's Do

A.	 1.	 Bevel adds thickness and rounded edges to shapes.

	 2.	� Word 2019 comes with a set of readymade shapes that we can use in our document. We can 
resize, rotate, flip, color, and combine the shapes with other shapes to make more complex 
shapes in Word.

	 3.	 Symbols are punctuations or special characters generally not found on the keyboard.

B.	 1.	 To change the outline colour of the shape, follow these steps:
	 	 Step 1	 Click on the shape to select it. 
		  Step 2 	Click on the Format tab
		  Step 3	� Click on the Shape Outline command.
		  Step 4	 Choose the outline colour and thickness.

	 2.	� WordArt allows you to create text effects that are not possible through text formatting. To 
apply WordArt effect to text, follow these steps:

		  Step 1	 Click on Insert tab.
		  Step 2	� Click on WordArt command.
		  Step 3	 Choose the desired style. A textbox will appear in the document.
		  Step 4	� Type text in the textbox and click outside the textbox.

	 3.	 To insert a scanned picture into a document from the computer, follow these steps:
		  Step 1	 Click on Insert tab.
		  Step 2	 Click on the Pictures command.
		  Step 3	 Browse to the location of the picture you wish to insert and select the desired image. 
		  Step 4	 Click on the Insert button.

Crack CodeThe

A.	

      
B.	 1    3    4    2
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Do yourself.

Worksheet–1
(Based on chapters 1 to 4)

A.	

General Purpose Software

Spreadsheets Image Processing 
Software

Application Software

Customised Software

Word Processors Presentation 
Software

Desktop Publishing 
Software

Multimedia 
Processors

Database Management 
Systems

B.	 1. Ctrl + F      2. Ctrl + H	 3. Ctrl + Shift + +	 4. Ctrl + Shift + Enter

C.	 1. Insert	 	   2. Page Margins

	 3. Booting   	    4. Lady Ada Lovelace

D.	 1. In 1944, Prof. Howard Aikens built the first electro-mechanical powered computer named 
Mark-I

	 2. �A computer provides a high degree of accuracy. Every calculation is performed with the same 
accuracy.

	 3. The WordArt gallery contains text styles to create text effects.

Test Sheet–1
(Based on chapters 1 to 4)

Section A
A.	 1. iii	
	 2. (This question was printed incorrectly in the book, please correct it in your textbook)
	 Q. Under which tab is the size command available?
	 (i) Design        (ii) Layout        (iii) View
	 Ans. ii	
	 3. i
B.	 1. F	 2. F	 3. F
C.	 1. subscript	 2. Lady Ada Lovelace	 3. Disk defragmenter
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Section B
A.	 1.	Fourth Generation of computers used microprocessors.
	 2.	Multimedia Software is used to combine the text with graphics, videos and sounds.
	 3.	Page margin is the white space all around the printed area of the paper.
B.	 1.	� WordArt allows you to create text effects that are not possible through text formatting. To 

apply WordArt effect to text, follow these steps:
		  Step 1	 Click on Insert tab.
		  Step 2	� Click on WordArt command.
		  Step 3	 Choose the desired style. A textbox will appear in the document.
		  Step 4	� Type text in the textbox and click outside the textbox.

	 2.	The two features of fifth-generation computers are:
	 	 (i) They use artificial intelligence. 
	 	 (ii) Improved size, cost, speed and performance.
	 3. �System software is the most important software to operate a computer. The operating system 

is a type of system software. System software can be classified into three categories: Operating 
System, Programming Software and Utility Software.

 Presentation Software—Special Effects

OneOne LearnTouch

A.	 1. b.	 2. c.	 3. c.	 4. c.

B.	 1. Placeholder    2. design    3. format    4. Justify

C.	 1. d	 2. a	 3. b	 4. c

ItLet's Do

A.	 1.	� A placeholder is a box in PowerPoint that contains dotted lines and are used to insert images, 
text, shapes, etc.

	 2.	� PowerPoint templates are well-developed presentations. We only need to change the text 
and our presentation is ready.

	 3.	� The four types of alignment are Left Align, Right Align, Center Align and Justify.
B.	 1.	 To insert Online pictures in the document, follow these steps:
		  Step 1	 Click on the Insert tab.
		  Step 2	 Click on the Online Pictures option.
		  Step 3	� Type a word in Bing Image Search box.
		  Step 4	� Select the picture, you want to insert.

5.
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		  Step 5	 Click on the Insert (1) button. 
	 2.	 To insert shapes on the slide, follow these steps:
		  Step 1	 Click on Insert tab.
		  Step 2	 Click on Shapes command in the Illustration group.
		  Step 3	 Choose a desired shape from the drop down menu.
			   The desired shape will be inserted on the slide.
	 3.	� A theme is a set of predefined layouts that can be used to add a professional touch to your 

presentations. 
		  To add WordArt to a slide, follow these steps:
		  Step 1	 Click on Insert tab.
		  Step 2	 Click on WordArt option.
		  Step 3	 Choose the desired style. 
		  Step 4	� Type text in the textbox and click outside the text box.

Crack CodeThe

1.  ‘Insert picture’ feature can be used to insert pictures in the slides.
2. � ‘Built-in templates’ can be used to add templates in the slide to make it look more colorful & 

attractive.

Do yourself.

 An Introduction to Scratch Programming

OneOne LearnTouch

A.	 1. a.	 2. b.	 3. a.	 4. c.	 5. c.

B.	 1. backdrop    2. stage    3. yellow    4. blocks

C.	 1. F	 2. F	 3. T	 4. T

ItLet's Do

A.	 1.	Two features of Scratch are:
		  (i)	 Easy to understand and learn

6.
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		  (ii)	 It has tools for creating interactive stories and games

	 2.	Sprite is an object that we see on the Scratch stage. The ‘Cat‘ is the default sprite.
	 3.	Motion block is used to sense events.
B.	 1.	� A Low Level Language (LLL) is a programming language that is machine dependent. A machine 

dependent language runs only on one particular type of computer.
		�  Whereas, High Level Language (HLL) is a programming language that enables a programmer 

to write programs that are machine independent.
	 2.	� Sound blocks are color-coded pink and are used to control sound. These blocks control the 

playback and volume of the sound files selected by you.
	 3.	� Motion Blocks are colour-coded dark blue and are used to control the sprite movement. 

When you click on the Motion button, we will see the programming blocks that can be used 
with the sprite for its placement, direction, rotation and movement.

	 4.	Steps to save a project are:
		  Step 1	Click on the File menu.
		  Step 2	Click on Save to your computer option.
		  Step 3	Choose the desired location.
		  Step 4	Type the project name in File name box.
		  Step 5	Click on Save button.

Crack CodeThe

1. Stage	 2. Backdrop	 3. Go button	 4. Script	 5. Scratch

Do yourself.

 Internet Services

OneOne LearnTouch

A.	 1. a.	 2. c.	 3. b.	 4. b.

B.	 1. F	 2. T	 3. T	 4. F	 5. F

C.	 1. Facebook    2. Dial-up    3. Online shopping    4. Wi-Fi    5. Internal Modem

7.
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ItLet's Do

A.	 1.	� Modem stands for Modulator Demodulator. It is generally used when users want to access 
Internet service provided by the Internet Service Provider (ISP) through their telephone line.

	 2.	� Online shopping allows us to buy various products such as grocery items, clothes, electronic 
gadgets, books, etc.

	 3.	� Online chatting allows us to interact with other people. It can be accessed to meet new people 
and make friends.

	 4.	Facebook, Twitter & LinkedIn
B.	 1.	� Wi-Fi uses radio frequency to connect to the Internet. Wireless connections are possible 

through the modem, which picks up Internet signals and sends them to computers.
		  Wi-Fi
		�  Wi-Fi doesn’t require cable to provide Internet access. The main advantage of wireless is the 

“always on” connection that can be accessed from any location under network coverage. 2. 
Sound blocks are color-coded pink and are used to control sound. These blocks control the 
playback and volume of the sound files selected by you.

	 	 Broadband Connection
		�  Broadband is provided through either cable or telephone companies. It is a high-speed 

Internet connection. You can share a large amount of data. It is significantly faster than a 
dialup connection and makes or receives phone calls. A broadband connection provides 
Internet access only through cable.

	 2.	� Etiquettes are the rules that are expected to be followed while meeting others or 
communicating with others. In Online communication, you may not be face to face with 
the person. There may be a situation when the person may misunderstand your remark. In 
order to avoid misunderstanding, a set of rules have been designed which are expected to be 
followed during Online conversation. This set of rules are  known as Netiquettes. It basically 
stands for Network Etiquettes.

	 3.	� E-mail stands for Electronic Mail. It allows us to send or receive electronic messages which 
can be text, picture and sound. With e-mail, we can communicate quickly and easily with 
millions of people across the world. It is an essential tool for business. It is also excellent for 
keeping in touch with family and friends.

Crack CodeThe

1. ISP      2. Modem	   3. Social Network	   4. Search Engines	

5. �(This question is printed incorrectly in the book, please correct it in your textbook) 

	 Q.	 I provide wireless internet access using WiFi technology over short distances  
		  (approx. 20 meters). 

	 Ans.	Hotspot
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Do yourself.

Worksheet-2
(Based on chapters 5 to 7)

A.	
Title Bar

Tabs

Blocks 
Menu

Script
Backdrop

Sprite

Stage Area

Coding Area

Go Button

Sprites Info Pane

Stop ButtonMenu Bar

B.	 1. WHATSAPP    2. NETIQUETTES    3. ALIGNMENT    4. MODEM    5. PRESENTATION

C.	 1. b	 2. c	 3. a	

Test Sheet–2
(Based on chapters 5 to 7)

Section A
A.	 1. �(This option of this question was printed incorrectly in the book, please correct it in your 

textbook)
	 Q. Which of the following tab is used to insert ready-made templates?
	      (i) Insert  (ii) Design  (iii) File
	 Ans. iii	
	     2. i	 3. iii
B.	 1. F	 2. T	 3. F
C.	 1. Wi-Fi      2. stage      3. Place holder
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Section-B

A.	 1.	There are four types of alignments in the PowerPoint like left, right, center and justify.
	 2.	Events blocks are colour-coded brown and are used to sense events which run the scripts.
	 3.	1. Facebook      2. Instagram      3. Twitter

B.	 1.	To save a project, follow these steps:

	 	 Step 1	Click on the File menu.

	 	 Step 2	Click on the Save to your computer option.

	 	 Step 3	Choose the desired location.

	 	 Step 4	Type the project name in File name box.

	 	 Step 5	Click on the Save button.

	 2.	To insert a WordArt on the slide, follow these steps:
	 	 Step 1	Click on Insert tab.

	 	 Step 2	Click on WordArt option.

	 	 Step 3	Select the desired style.

	 	 Step 4	Type text in the textbox and click outside the textbox.

	 3. a. �E-mail stands for Electronic Mail. E-mail allows us to send or receive electronic messages 
which can be text, picture and sound.

	   b. �Dial-up requires users to link their phone line to a computer in order to access the Internet. 
It doesn’t allow users to make or receive phone calls through phone service while using 
the Internet.




